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[StarVision User Manual] 
This document will quickly introduce you to the wonders of the MallinCam StarVision 

Camera. It will include instructions on how to install the Software and Drivers and how 

connect the StarVision to your computer along with explanations of the camera’s 

major settings.  The purpose of this guide is to quickly get you up and running with the 

StarVision Camera so that you can quickly enjoy the process of imaging.   
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1. Introduction  

For several years, MallinCam has been researching the production of a USB 

camera that shares some of the features and technologies incorporated in our 

MallinCam Xterminator true vision True video CCD cameras, as well as adding 

several upgrade features. One of these is the use of the Sony ICX825AQA CCD 

sensor. This sensor is 11mm measured diagonally versus 8mm for the Xterminator; 

thus providing a wider field of view, which is desirable for larger objects. In 

addition, this sensor is capable of producing pinpoint stars with zero-star artifacts 

and zero amp-glow. This camera can be used both in light polluted urban 

environments or at dark sky sites. It will excel at outreach events where 

MallinCam has been leading the world market with its full line of video astronomy 

cameras for live applications. 

 

At the heart of the StarVision are internal dual memory modules. This feature is 

not found on the competition’s cameras. By having dual internal memory 

modules, the data transmission load needed is dramatically reduced. Also, by 

incorporating DSP (digital signal processing) and other MallinCam developed 

noise reduction technologies, the StarVision achieves a level of low noise not 

achieved by other ICX825 CCD cameras. 

 

Cameras from other manufacturers containing the ICX825 CCD sensor produce 

single frame images suffering from noise. To achieve acceptable images, 

stacking of multiple frames is needed. The StarVision is capable of producing 

excellent smooth, live, noise free images without the need for stacking. 

 

The front circuit board containing the CCD sensor is free of any other electronic 

components. This eliminates electronically induced noise from affecting the 

sensor and dramatically reduces heat from reaching it. This technology is not 

utilized by other camera manufacturers. In addition, industrial grade 

components are used throughout the cameras three double sided populated 

circuit boards. Finally, the front CCD sensor board is made with 24 karat gold 

plating to insure the ultimate in connection integrity and low noise performance. 

Careful planning went into the design of this ultra-compact USB camera, making 

it usable with ALT-AZ and EQ mounts. 

 

The StarVision is designed and built for a lifetime of durability. The body is 

composed of CNC machined aluminum and stainless steel, and the machine 

screws are also of stainless steel. The rigidity of the case ensure that the sensor will 

maintain permanent alignment and the sealed, clear, multicoated optical 

window insure that the CCD sensor will never need cleaning. This insures low 

maintenance. The professional USB2.0 locking terminal and cable are designed 

for use in all environments and are especially suited for use outdoors. 
 

Special thanks to Jim Thompson, Jack Huerkamp and Rock Mallin whose 

expertise and experience are way beyond my capabilities. 

 

So, thank you for your purchase, and let the adventure begin. 
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The Contents of the StarVision Package 

 

Specifications: 

 

 
 

• PC Win XP, Win7, Win 8, and Win 10 

•  Support and includes Full Trigger Mode 

• IMX825AQA EXview HAD II Scientific Grade CCD Sensor 

• 11mm (Type 2/3) Diagonal 

•  Approximately 1.45M Effective Pixels 

• Progressive Scan 

• 6.45x6.45 Micron Square Pixels 

• 2000mv Sensitivity 

• Color (Monochrome Available) 

• Binning Mode 

• Monochrome Mode Available For Color Sensor 

• Ultra Compact 2”x2”x1.5” Size 

• 6.80 Ounces (192 Grams) 

• Professional, Industrial USB2.0 Locking Terminal 

• 15’ USB2.0 Professional Grade Cable with Locking Connection 

• Aluminum and Stainless Steel CNC Construction 

• Gold Plated Main CCD Board 

• Sealed CCD Chamber 

• Live Observing and Imaging Modes 
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System Requirements: 

• Equal to Intel Core2 2.8GHz or Higher 

• Memory: 2GB or More 

• USB port: USB 2.0 Port 

• Display: 17" or Larger Recommended 

 

 

In the Box 

 

The StarVision includes the following standard equipment: 

 

➢ MALLINCAM StarVision Camera  

➢ High Precision 1.25" C mount Eyepiece Adapter 

➢ 15’ USB 2.0 Professional Grade Cable with Locking Connection. 

 

Software Updates and Drivers can be down-loaded at the Software Downloads 

Window located in the Support Tab at www.mallincam.net 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.mallincam.net/
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2. Installing Driver and Software 

System Requirements 

PC running either Windows ® (32-bit & 64-bit) 7, 8, 8.1, 10 

 

Performance is not guaranteed if the following specification cannot be reached.  

 

• DirectX 9.0 or later installed 

• 2.8GHz processor (Recommend dual core 2.8GHz or more) 

• USB 2.0 Port 

• 2GB RAM (Recommend 2GB or more) 

• 200MB Free HDD 

Installing the Software 

Visit the Software Downloads Page in the Support Tab located on the website: 

www.mallincam.net 

 

 
 

Select the Blue Click Here Button to download the Drivers and StarVision 

Software for a Windows PC). 

 

 
 

 

You will be installing all drivers, including Twain and DirectShow. 

 

 

Make sure that the StarVision is not plugged into the computer. 

 

 

Step 1 

Step 2 

http://www.mallincam.net/
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Locate the MallinCam Sky_Drivers Download Icon on your download location. 

 

 
 

Depending upon the version of Windows, either Right Click on the Icon, then just 

Click on the Extract button, else Double-Click on the Icon and jump to Step 8.  

Windows should now open up the actual folder that contains the software to 

install.  

 

 

Double-Click on the folder to open it up, revealing the 4 programs it.  

 

 
Double-Click on the Installer.exe file and the Installer window will open. 

 

 

 
 

The Install Check should be active, so Simply click on the Perform Button. Then 

accept any warnings or permissions and the StarVision software and drivers will 

be installed.  

 

Click the OK Button when installation is finished. 

 

 
 

Step 3 

Step 4 

Step 5 

Step 6 

Step 7 

Step 8 
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You may need to close the Installer Window when process completed. 

 

 

 
 

 

You should now have the MallinCam Icon on your desktop, ready for you to start 

imaging. 
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3. Connecting the StarVision  

Connecting the StarVision to your Computer 

 
Remove the rubber dust cover from the front of the StarVision camera (place it 

back in the box for safe keeping). 

 

 

 

 

Screw in the C-mount adapter to the front of the 

StarVision. 

 

 

 

 

 

 

 

 

Insert the StarVision (with C-Mount attached) 

into a 1.25” eyepiece adapter on your 

Telescope. 

 

 

 

 

 

Depending upon the telescope, you may need extenders so that you can reach 

focus with your telescope. It is recommended that you set this up in the daytime 

so you can see what you are doing (plus can aim at an easy to find tree or 

telephone pole).  
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Attach the 5 metre USB 2.0 Cable from the back of the StarVision (lock it in place 

with the two securing screws) to a free USB 2.0 port on your computer. 

 

The StarVision has some strict power and thru-put requirements, and not all 

computers are created equal. If you find you are having difficulties with the 

following steps, it maybe the USB 2.0 port on your computer. If that is the case, 

one option to try is; connected a Powered USB 2.0 Hub to your USB 2.0 port on 

your computer. This simple step, can improve, both thru-put, power and distance 

between your computer and the StarVision camera. 

 

 

 

 

 

 

 

 

 

 

 

 
 

Windows will then automatically load the correct StarVision Camera Driver onto 

your computer. 

 

 
 

  

Hint 
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4. Using the StarVision Software 

The StarVision Window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The StarVision Software Window is segmented into a few regions to make viewing 

and adjusting the StarVision camera easy and intuitive. 

 

① The Top Menu Line provides dropdown menus and icons to allow you to 

make major settings of the software 
 

②  The StarVision Left SideBar provides the simple click activation and selection 

capabilities to control all aspects of the image and camera. 

 

③ This Line provides single touch icons to allow for quick access to commands. 

 

④ The Video Window will contain the display image from the StarVision 

Camera. It is here that you will see the live video, or images. 

 

⑤ The Information Line will indicate the current camera, current frame rate, 

number of frames displayed, resolution, information about captures, etc. 

 

 

 

 

① 

② 

③ 

④ 

⑤ 
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StarVision Quick Setup and Pictorial Work-Flow 

A typical workflow when using the StarVision with the Mallincam Software. 

  Start Mallincam 

Deep Sky Object Planetary 

Take Dark Field 

Long Exposure to Image 

Activate Dark Field 

Short Exposure to Focus 

Adjust Image 

Save and Record 

Exit Mallincam 

Exit Mallincam 

Save and Record 

Live Stack 

Short Exposure to Image 

Adjust Image 

Light Frequency DC 
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Live Stack Pictorial Work-Flow 

A typical workflow when Live-Stacking with StarVision. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Expose Object 

Live Stack 

Adjust Image 

Save and Record 

Choose type of Stacking 

Adjust Image 

Adjust Color 
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Histogram Pictorial Work-Flow 

A typical workflow when using the Histogram Command with StarVision. 

 

 

 

 

 

 

 

 

 

  

Expose Object 

Increase Left number 
or Move Left Bar in 

Darkens 

Increase Right number 
or Move Right Bar in 

Brightens 

Select Histogram 

Select Exposure 

Decrease Exposure 
Increase Exposure 

Histogram Moves to 
Left 

Histogram Moves to 
Right 



StarVision User Manual October 4, 2016 

Mallincam StarVision User Manual Page 17 

ROI Pictorial Work-Flow 

A typical workflow when using the Fast ROI Command with StarVision.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Expose Object 
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Dark Field Pictorial Work-Flow 

A typical workflow on how to Take and Apply Dark Fields. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Expose with Lens Cap On 

Select the Capture Button on 
Camera Exposure 

Expose Object 

Done 

Check Enable 

Save Dark Field if Necessary 
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More Detailed Work-Flow Procedure 

 

Quick Workflow for StarVision 

 

So, you don’t like to read manuals, and you just want to just jump right into 

imaging. Then this section gives you a Quick and Dirty method to get going. 

Then, I follow this section with an even more detailed section on Planetary 

Imaging Workflow, and finally a more detailed section on Workflow on Imaging 

Deep Sky Objects. 

 

The Mallincam StarVision Cameras provide a processing technique called Dark 

Field Correction (see the Section Dark Field Explanation in the Appendix for a 

complete description of Dark Field Correction).  

 

Double Click on the Mallincam StarVision Icon to start the program.  

 

 

 

You should be presented with the StarVision Main Window with the settings last 

used. 

 

 

 

 

 

 

 

 

 

 

 

If not already selected, ensure that the Camera Setup Tab is selected. This should 

be the default setting and you will have Camera Exposure Window on top and 

Output Window below. 

 

If you are imaging planetary objects, jump to Step 6. 

 

 

 

Select an Exposure Time for Dark Field Correction 

 

With the Camera Exposure Tab selected on 

the Left SideBar, enter a desired exposure 

that represents the maximum exposure you 

plan to use during tonight’s session. You can 

either enter in values into the appropriate 

time units, or use the up-and-down arrows to 

select the exposure time. 

 

Step 3 

Step 1 

Step 2 
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I would recommend that you set the Light Frequency to DC (but this is up to you 

and your preference, but at DC you can use lower exposure values).  

 

 
 

 

Take Dark Field Correction 

 

Ensure that the Lens Cover is either on the StarVision 

Camera or the Telescope itself is Covered (Cap is on), 

then Left-Click on the Capture button in the Dark Field 

Correction section in the Camera Exposure Tab.  
 

The StarVision Software has an Output Window that displays the commands as 

they are executed on the camera. This window should be below the Camera 

Setup Window. 

 

 
 

 

 

As the Dark Field is being exposed, you can watch the 

exposure counter in the Remaining Time line just below the 

Exposure control. 

 

 

  

Once the Dark Field has been taken, you have the option of saving (so you can 

use then again on another night) them with the Export button in the Dark Field 

Correction line.  You can import previously saved Dark Field by using the Import 

Button. 

 

Now, Left-Click in the Enable check box in the Dark 

Field Correction’s box to have the Dark Field 

applied in real time to your images.  

 

 

 

Step 4 
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Reduce Exposure Time to Align Telescope 

 

As you will most likely use the camera to align your Telescope, now is the time to 

reduce the Exposure Time to 1 or 2 seconds, and if not already attached to the 

Telescope, remove the lens cap from the StarVision Camera and insert the c-

mount on front end of the camera and slide camera into eyepiece holder of 

telescope. The shorter exposure will make it easier for you to align and focus your 

telescope. 

 

 

Increase Exposure Time to Image 

 

Now is the time to expose some Deep Sky Objects or Planetary Objects. So, enter 

in a larger exposure time (if you are imaging Deep Sky Objects, else remain in 

the short exposure time if imaging Planetary Objects) and adjust the Exposure 

Time to match the current target and the equipment you are using.  

 

If you have enabled the Dark Field Corrections for this session (Dark Fields are 

stored directly in the StarVision Camera and will be deleted when the camera is 

turned off), the StarVision will automatically apply the Dark Field Correction to 

your image when Dark Field Correction is enabled. 

 

 

Adjust the Parameters 

 

Choose a parameter from the Image Tab on the Left 

SideBar and see what you can adjust, and how it affects 

your image.  

 

You will have to wait until the next image is exposed to 

see how your adjustments look (keep an eye at the 

bottom of the screen to see when the next adjusted 

image will appear). 

 

 

Have Fun and Experiment 

 

You can now spend some time to become more comfortable with the 

Mallincam StarVision Software. This User Manual will go into more detail about all 

of the options and adjustment you can perform with the StarVision camera. But, 

don’t be afraid to experiment. 

  

Step 5 

Step 6 

Step 7 

Step 8 
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Detailed Workflow of Video Imaging Planetary Objects 

  

The following instructions will guide you in setting up your StarVision camera for 

imaging Solar, Lunar, or Planetary Objects. 

 

For planetary objects, the exposure setting will be very small (as the objects 

themselves are usually very bright). It is recommended that you start imaging 

objects, such as the Moon and Planets, as it will allow you to become 

comfortable with all of the adjustments that StarVision provides for you. With 

planetary objects, you want as much resolution and data as possible, so choose 

the highest resolution in the Camera Setup Tab that your StarVision provides for 

you. (which is 1390 x 1024). 

 

 

 

 

Since the exposure rate is so short, you may find that you do not need to take 

any Dark Fields preparation shots before imaging. But if you do notice warm 

pixels and would like to eliminate them. Then follow the step-by-step instructions 

located in the section called: Dark Field Correction later in the manual. 

 

 

 

If not started, Double Click on the StarVision Icon on your Desktop to start 

the program.  

 

 

If not already selected, ensure that the Camera Setup Tab is selected. This should 

be the default setting and you will have Camera Exposure Window on top and 

Output Window below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2 

Step 1 
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Have your telescope pointed to the Planetary Image of interest, and it is 

recommended that you use a Barlow Lens attached to your Telescope to 

provide a “Larger (Longer Focal Length)” image. 

Since you will want to “push” the capabilities of the StarVision in displaying the 

Planetary object, you will require the highest resolution that your particular 

StarVision can produce, along with the largest bits of data (for color or shades of 

Back and White) for each pixel that the StarVision is able to produce. This will 

provide enough data for external stacking programs to pull out the finest detail 

from your video images. 

From the Camera Setup and Resolution sections on the StarVision Camera Setup 

Tab, select the Largest Resolution values, the fastest Super Frame Rate, and 

highest 12 bit resolution that your StarVision is capable of. 

 

If you have a slow computer, you may need to lower the Resolution, Frame Rate, 

or Bit Count to match the capabilities of your computer. 

 

 

So, let’s get started: 

 

➢ Set your exposure to a small value, say 10ms as a starting point (we are 

using a small time, but the actual exposure amount depends upon the 

f/ratio, size of telescope, filters, seeing conditions, ...). You can adjust the 

exposure using one of the two methods below: 

o You can either use the mouse button and Click on the little up and 

down arrows beside the appropriate time unit to adjust that time 

unit’s value higher or lower. 

o You can Click on the Exposure Time’s current setting and enter the 

required exposure time in the appropriate time box. 

 

 
 

Step 3 

Step 4 

Step 5 
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You should be able to see the Planetary object of interest on your screen. 

So now adjust the Exposure Time to make the object bright enough 

match you viewing requirements. You can also adjust the Gain just above 

the Exposure Title to brighten your image (the larger the gain, the brighter 

the image, but the larger the gain the larger the number of introduced 

artifacts in the image).  

 

 
 

Now is the time to adjust the Image in the Image Tab (Contrast, Gamma, …) to 

your required preferences. 

If the appropriate check boxes are not set, then the StarVision uses its internal 

defaults. So, to adjust Click on the appropriate check box and then use the 

Slider to adjust the setting. The image will adjust in real-time. See later in the 

manual for a detailed description of each of the settings. 

 

 

 

 

You can adjust the setting to a particular value, but when you uncheck the 

check box, the camera will revert to its default setting. But, by again Clicking on 

the Check Box, the control will be reactivated to the slider’s setting. 

 

Read the appropriate section in the User Manual (it is great reading, if I do say so 

myself) to obtain more information what each particular setting does in the Color 

Balance and Color Adjustment Tabs in Mallincam’s StarVision software. There is 

no precise value for every user, as we all use different equipment. This is a great 

time to ‘play’ with the settings to see what value work best for you. Just have fun. 

To improve the Though-put (Frames per 

Second) or if you want to isolate the 

planetary object, choose a Region of 

Interest (ROI) that just includes the image 

of the planetary object. You select the ROI 

by either using the Fast ROI Button or the 

ROI Setup Button located in the Camera 

Setup Tab. 

Step 6 

Step 8 

Hint 
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The Fast ROI Button, once clicked, will allow you to draw a rectangle around the 

Object that you would like to isolate by holding down the Left Mouse Button and 

Dragging to contain the object. Once enclosed, simply release the button and 

the screens image will now only contain what you had selected.  

     

You will see, on the Icon Row, the Screen Resolution and the Capture Resolution 

indicators both say ROI to remind you that you are in ROI Mode. 

 

 
 

 

 

 

To return back to Full Video Mode, just choose the Screen Resolution that you 

require from the left Screen Resolution drop down list (1360x1024). 

 

 
 

Using the Scroll Wheel on your mouse, when the mouse is over the Image 

Window, will enlarge and reduce the image size in the Image Window. 

 

To finely adjust the image characteristics, open up the Histogram Tab (it is next to 

the Camera Setup Tab). 

 

Once selected the Top Left Panel will show a real-time Histogram of the current 

image. 

 

 

Step 9 

Hint 

Screen 
Resolution 

Capture 
Resolution 
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You can adjust the values using the up and down arrow next to the Left and 

Right values so that you are not clipping data, on either side of the window. 

These adjustments will help improve the image on the screen. The Histogram Tab 

will take a bit of practice to become comfortable with it (read section in the User 

Manual covering the Histogram Command). As you adjust the Left and Right 

values, you will notice the Black Histogram Indicator Bars move to the left or right. 

The data is represented by the colors on the Histogram. 

 

 

The last couple of image adjustments you can make is located in the Color Tab 

of the Camera Setup Tab. 

 

 
 

Here you can adjust the individual Color’s Gain, Saturation, and the White 

Balance. 

 

When either the Area WB or Once WB is selected, the software will adjust the Red, 

Blue, and Green Gain for the image. But, you are free to re-adjust them by 

dragging the sliders to any value that improves your image. 
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Detailed Workflow of Video Imaging Deep Sky Objects 

 

The following instruction will guide you in setting up your Mallincam StarVision 

camera for imaging Deep Sky Objects (DSO). 

 

For Deep Sky Objects, the exposure setting will be very large (as the objects 

themselves are usually very dim). It is recommended that practice 

imaging bright objects, such as the planets, as it will allow you to 

become comfortable with all of the adjustments that StarVision 

provides for you. With Deep Sky Objects, you want as much 

resolution and data as possible, so choose the highest resolution your StarVision 

provides. 

 

Since the exposure rate can be very long, you will need to prepare your system 

by taking Dark Fields. If this is the first time imaging DSO’s, you may not have 

saved previous Dark Fields, so this Walk-Through will take you through the Dark 

Field preparation step.   

 

Remember complete explanations of each of the processes and controls are 

provided later in the User Manual. The following instructions are used as a guide 

to assist you in doing Deep Sky imaging.  

 

Have your StarVision connected to your telescope, and since you are video 

imaging Deep Sky Objects, you should have a Focal Reducer attached. This will 

provide you two benefits: first you will be presented with a larger field of view 

(see more of the object), and second, you will have a faster telescope (shorter 

exposure times). 

 If not Started, Double Click on the Mallincam StarVision Icon on your Desktop to 

start the program.  

 

If not already selected, ensure that the Camera Setup Tab is selected. This should 

be the default setting and you will have Camera Exposure Window on top and 

Output Window below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2 

Step 1 
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Since you will want to “push” the capabilities of the StarVision in displaying the 

Deep Sky Objects, you will require the highest resolution that your particular 

StarVision can produce, along with the largest bits of data (for color or shades of 

Back and White) for each pixel that the StarVision is able to produce. This will 

provide enough data for external stacking programs to pull out the finest detail 

from your video images. 

From the Camera Setup and Resolution sections on the StarVision Camera Setup 

Tab, select the Largest Resolution values, the fastest Super Frame Rate, and the 

highest 12 bit resolution that your StarVision is capable of. 

 

If you have a slow computer, you may need to lower the Resolution, Frame Rate, 

or Bit Count to match the capabilities of your computer. 

 

Due to the Large Exposure times you will be using in imaging Deep Sky Objects, 

the StarVision (in fact every camera no matter what the cost) will sometimes 

display noise such as, warm pixels and amp glow. The longer the exposure the 

more noise that can appear on your image. The StarVision software can remove 

this noise, by applying pre-prepared Dark Fields to your images, effectively 

removing the noise. 

  

Either place the Lens cap over your Telescope, or place the dust cover cap over 

your StarVision camera to block any light from hitting the sensor of the camera. 

 

Determine the maximum exposure time that you will be using for the evening, 

but to get started for the first time, we will choose a 30 seconds Exposure. Adjust 

the Exposure to 30 seconds in the Camera Exposure Tab (make sure Auto Exp is 

unchecked). The Remaining Time indication will start counting down. 

  

StarVision Software may adjust the time, very close to 30 seconds based on its 

internal exposure correction techniques. 

Step 4 

Step 5 

Step 3 
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Take Dark Field Exposure 

 

 

Click on the Capture Button in the Dark Field Correction section of the Camera 

Exposure Tab to initialize the Dark Field capture. 

 

 
 

Once the Remaining Time indication has completed it cycle, you should see the 

line Dark Field Correction Inited! appear in the Output Window. 

 

 
 

If possible and you know what Gain settings you are going to use, apply those 

settings as well before taking a Dark Field. 

 

 

You now have the option of saving the current Dark 

Field by Clicking on the Export… Button in the Dark 

Field Correction section. The software will open up a 

location for you to save your Dark Fields.  

 

 

We recommend to create a Dark Field location to save you Dark Fields, and 

using a naming technique so you can recall that specific Dark Field for later use.  

 

 

Step 6 
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You can apply the Dark Field at any time by just Checking the Enable 

Checkbox. To disable Dark Field, just Uncheck the checkbox. 

 

 

 

 

 

Center Deep Sky Object 

 

We will use a small exposure so we can verify that the object is someplace in the 

field of view (if in using 1 second the star or object is too dim, increase exposure 

to 2 seconds).  

If the image is too dim, try increasing the Gain.  

 

Now, you have your Deep Sky Object (or a least a dim version of it, centered in 

your screen. It is time to crank-up-volume. Well, for us, time to increase the 

exposure time. 

Increase the Exposure 

Set the exposure to a time that provides you with an image you are happy with. 

In this example set the exposure to 30 seconds. 

 

The Remaining time will count down and after the Remaining Time has reset, the 

image of your Deep Sky Object will appear on your screen. The image will be 

updated each time the Remaining Time re-cycles. 

 

You can now apply the Deep Field correction (Click on the Enable checkbox) if 

you have previously taken a Deep Field exposure. 

 

    
 

 

Step 8 

Step 7 

Hint 

Before Deep Field Correction After Deep Field Correction 
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Now, we are heading into the “Art” of video imaging. You can decrease the 

Exposure Time, as long as you increase the Gain. But, by increasing the Gain, you 

also increase any noise that is present. Use your own judgment in what you are 

willing to accept on your image. 

 

Obtaining an Image of our First Deep Sky Object is enough for most to start the 

celebration process (again most of us will call for our spouse to have a look at 

the amazing image we have just produced, again trying to justify the money 

used in buying those extra pieces of hardware). 

 

Next, we want to fine tune our image to perfection (at least that is what you will 

tell yourself), but this is a great time to get familiar with some of the adjustment 

options available in the Mallincam StarVision Software. 

 

Now is the time to adjust the Image in the Image Tab (Contrast, Gamma, …) to 

your required preferences. 

If the appropriate check boxes are not set, then the StarVision uses its internal 

defaults. So, to adjust Click on the appropriate check box and then use the 

Slider to adjust the setting. The image will adjust in real-time. See later in the 

manual for a detailed description of each of the settings. 

 

 

 

 

You can adjust the setting to a particular value, but when you uncheck the 

check box, the camera will revert to its default setting. But, by again Clicking on 

the Check Box, the control will be reactivated to the slider’s setting. 

Read the appropriate section in the User Manual (it is great reading, if I do say so 

myself) to obtain more information what each particular setting does in the Color 

Balance and Color Adjustment Tabs in Mallincam’s StarVision software. There is 

no precise value for every user, as we all use different equipment. This is a great 

time to ‘play’ with the settings to see what value work best for you. Just have fun. 

To finely adjust the image characteristics, open up the Histogram Tab (it is next to 

the Camera Setup Tab). 

 

Step 9 

Hint 

Step 10 
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Once selected the Top Left Panel will show a real-time Histogram of the current 

image. 

 

You enter in a value via the of use the up and down arrow next to the Left and 

Right values so that you are not clipping data, on either side of the window. 

These adjustments will help improve the image on the screen. The Histogram Tab 

will take a bit of practice to become comfortable with it (read section in the User 

Manual covering the Histogram Command). As you adjust the Left and Right 

values, you will notice the Black Histogram Indicator Bars move to the left or right. 

The data is represented by the colors on the Histogram. 

 

 

The last couple of image adjustments you can make is located in the Color Tab 

of the Camera Setup Tab. 

 

 
 

Here you can adjust the individual Color’s Gain, Saturation, and the White 

Balance. 

 

When either the Area WB or Once WB is selected, the software will adjust the 

Red, Blue, and Green Gain for the image. But, you are free to re-adjust them by 

dragging the sliders to any value that improves your image. 
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This is where you have to take over, as each telescope, night-sky, seeing 

conditions are different from user to user. So, have fun and experiment with the 

settings and see how they affect your image. Remember, these are your images 

and you decide what is best for you. 
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5. The StarVision Software Controls 

This Chapter of the User Manual will describe in exact detail what each control 

on both the Top Line Menu and the Icon Toolbar does. This Chapter is best read 

on a rainy day, or can be used to jump to the specific section that describes 

how to use a particular control. 

 

 
 

The StarVision Software’s Docking Controls 

One of the unique properties of the StarVision Software is its ability to allow you to 

modify its display panels. 

 

The Software has its default panel locations and even default icon placement, 

but the software allows you to modify these to suite your needs (later versions of 

the software will allow you save you modified positions so they appear in your 

preferred location automatically when you start the software). 

 

Icon Bar 

 

You can slide the Icon Bar’s subsection by left-click-hold-and-dragging the 

index marker ( ) to a new location. This location can be on or off the menu bar, 

or even off the StarVision’s Main Window (even onto another monitor, if you are 

using two monitors). 

 

These Icon Subsections contain a set of chosen symbols automatically 

chosen for their related operations. You can change the size of these 

subsections, or even (by clicking on that Subsection’s Down Arrow) modify 

what icons are included in that Icon Subsection. You have complete 

control. 
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We recommend that you keep the chosen icons in 

their respective subsections as it will be easier for 

you to locate the icon of choice, but this is your 

software and you can modify it to the way you 

prefer. 

 

 

Clicking on the X (the close symbol) on the Icon Subsection will remove that 

section from the display. You can reactivate that Icon Subsection thru the View-

>Tool Bar Tab at the top of the screen. 

 

Dragging the Icon Subsection close to the original position will cause the Icon 

Subsection to snap into place. 

 

 
 

Control Windows 

 

You can also drag the Control Windows off StarVision’s Main Window and place 

them wherever you want. This option, for example, allows you to place the 

Camera Setup and Output Box on one monitor and the Actual live image 

Window solely on another monitor. 
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Double Clicking on the Camera Setup Title or Output Title on the respective 

Window will automatically return them back to their original position. 

 

By clicking on the Anchor symbol, you can even have the Window’s Tabs 

appear on the Side of your StarVision Screen, and slide in horizontally. 

 

 
 

This will allow you to just place your cursor over the Side Tab, and that window 

will slide over part of the image to allow you to make adjustments. Just slide your 

mouse over the image and the side window will slide back closed. 

 

 
 

 

When it is time to place everything where you had it when you started, you may 

notice that when dragging a window around the monitor that translucent arrow 

symbols appear on the screen.  

 

 
 

Dragging your Window onto a specific symbol will dock the Window in that 

location (you will see that location high-light when window is dragged over 

symbol, just release mouse button to place it there). With just a bit of practice 

you will be able to move and resize all of the StarVision Windows to meet your 

needs. 
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Top Menu Line 

 
 

 

File(F) 
 

This Drop-Down Menu will allow you to Load and Save 

images, take image snapshots, as well as load and 

save the parameter settings for the StarVision 

camera. You can also reset the StarVision camera 

back to its default settings from the File Drop-Down 

list.  

 

 

 

 

 

 

 

 

 

 

Open Camera 
 

The Open Camera command is used to open an existing StarVision Camera that 

is connected to your computer. If you have more than one StarVision camera 

connected, you can use this command to activate a selected model form the 

displayed list.  

 

Once selected, the StarVision software will open up 

a Window displaying a list of compatible camera 

connected and their current status. Just select the 

Compatible model that you would like to view and 

click on the OK Button. That camera’s image will 

then display in the StarVision Video Window. 

 

 

The status indicates which camera you are currently using (Playing). 

 

 

Open Image  
 

Use the Open Image Command to open an existing saved image on your 

computer and display it in a Video Window Tab.  
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Once selected, the Open Image 

Command will open up a Window 

that allows you to select an image 

saved on your computer. You can 

use the window to locate a folder, 

and select an image file to display 

in the StarVision Software Window.  

 

The only format currently accepted 

is in the Bitmap format (bmp) 

 

Once the Image is selected, the software will create a Window Tab and will 

display the selected image. The StarVision’s Active Camera Tab will be available 

for you to select, if you would like to return to its window. 

 

 
 

You can open as many Image Window as you need, you need only select the 

Tab that matches the Image File Name of interest. StarVision will close the Left 

Camera Setup Window and will open the Image List Window in its location.  

 

 

 

 

If you require the Camera Setup and 

access to the camera controls, first 

select the Mallincam Vision Camera’s 

Active Tab to display the StarVisions’s 

image.  

 

This will then allow you to select the 

Camera Setup Tab from the Left Action 

Tab. Just Click on the Camera Setup 

Tab to reactivate it. 
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Close Current Window    
 

The Close Current Window command will close the current Video Window Tab 

that is opened. If it is a previously opened Image File, that image will be closed. If 

the current Tab is a StarVision Camera, then the camera will be shut down. 

 

You can re-activate the StarVision Camera by using the File->Open Camera 

command from the Top Command Line. Then you should see your camera in the 

Open camera (Searching…) pop-up window with the Status displaying 

Connected. Click on the Mallincam Vison camera to select it and then Click on 

the OK button to activate it. 

 

 
 

 

Close All Windows  
 

This command will close ALL image and live camera 

windows. Just Click on the Yes Button when the 

Confirmation Window pops-up. See the above Note on 

how to reactivate the camera after it has been shut-

down. 

 

 

Save   
 

This command will take a Snapshot of the current camera image and will save 

that image in the format(s) and location specified in the Settings->Capture 

Settings image location using the specified naming convention. 

 

You can open up the Image List Window on the left of the program so you can 

see a preview (bmp format) of the currently saved images.  

 

You can double click on the preview image to open it up in the Video  

Window Tab. 

 

If you require the Camera Setup and access to the camera controls, just Click on 

the Camera Setup Tab to reactivate it. 
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Save as   
 

This command will take a Snapshot of the current camera image and will save 

that image in bmp format to the location specified in the Save As Pop-up 

Window that appears. Use the Window to select a location, files name, and 

format that you would like the image to be saved under.   

 

 
 

Snap   
 

This command (so far identical to Save Command) will take a Snapshot of the 

current camera image and will save that image in the format(s) and location 

specified in the Settings->Capture Settings->General.  

 

You can open up the Image List Window on the left of the program so you can 

see a preview (bmp format) of the currently saved images.  

 

You can double click on the preview image to open it up in the Video  

Window Tab. 

 

If you require the Camera Setup and access to the camera controls, just Click on 

the Camera Setup Tab to reactivate it. 

  

 

Continuous Snap   
 

This command will take continuous Snapshots of the current camera image and 

will save those images in the format(s) and location specified in the Settings-

>Capture Settings->General image location taking the specified number of 

imaged with an indicated time separation between each image as defined in 

the Settings->Capture Settings->Advanced tab.  When activated, the 

Continuous Snap Command will have a checkmark beside it, to remind you that 

the software is taking continuous snapshots. 
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The Mallincam StarVision Software will continue taking snapshots until you again 

Click on the Continuous Snap Command. 

 

You can open up the Image List Window on the left of the program so you can 

see a preview (bmp format) of the currently saved images.  

 

You can double click on the preview image to open it up in the Video  

Window Tab. 

 

If you require the Camera Setup and access to the camera controls, just Click on 

the Camera Setup Tab to reactivate it. 

 

 

Save Camera Parameter   
 

This command will allow you to save the current settings that you have set for the 

StarVision Camera. The software will open up a Save as Window and you will be 

allowed to choose a location and a file name for the parameter file (.ini format) 

The ini files contains all of the Star Vision camera settings you have made on the 

camera along with image locations and file formats. 

 

It is recommended that you choose a file name that makes sense about the 

current camera settings (deep Sky, Mars, mag 3 skies,…). 

 

Once you have chosen a name and location, Click on the Save Button to save 

the .ini file. 
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Load Camera Parameter   
 

This command will allow you to load a parameter settings file that you have 

previously saved for the StarVision Camera. The software will open up an Open 

Window and you will be allowed to choose a location and a parameter file (.ini 

format) that you have previously saved. The Software will then adjust the current 

StarVision camera settings to match he file’s contents. 

 

 

Default Camera Setup   
 

This command will reset the StarVision settings to the factor default. Use this 

command if you get totally lost in the settings you have adjusted for the camera. 

 

 

Exit   
 

This command will shut down the StarVision camera and will them terminate the 

Mallincam StarVision Software. You use this command when your imaging session 

is over and you want to turn off the software and camera. 
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View(V) 
 

This Drop-Down Menu will allow you to choose what 

information and commands you would like to be 

displayed on the Mallincam StarVision Software.  

 

  

 

Tool Bar   
 

On choosing this control, the software will open-up its side drop-down list where 

you can select which one-click-icons you would like to see displayed on the 

Icon Tool Bar at the top of the screen. The checkmark will indicate if the 

matching set of icons are displayed. 

 

The following is a description of each of the Icon Tools Bar options: 

 

 

General Bar  
 

The General Bar Icons allow for quick access to commands that appear on the 

Tab line or appear within a specific Tab. The descriptions of each of these 

commands appear within the User Manual in the Tool Bar Icon section. 

 

These set of icons include: 

 

•  Open Camera 

•  Open Image 

•  Play (activate StarVision camera’s video stream) 

•  Stop (pause StarVision camera’s video stream) 

•  Snapshot 

•  Continuous Snapshot 

•  Real Time Snapshot 

•  Save 

•  Save As 

•  Settings 
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Size Bar  
 

The Size Bar Icons allow for quick access to commands that control the size of 

the actual Video Window that is displaying the video signal being captured by 

the StarVision camera.  The descriptions of each of these commands appear 

within the User Manual in the Tool Bar Icon section. 

 

These set of icons include: 

 

•   Zoom In 

•   Zoom Out 

•   Percentage Size Drop-Down list  

•   Image Aspect Ratio  

•   Adapt Window Size 

•   Full Screen 

 

Cursor Bar   
 

The Cursor Bar Icons allow for quick access to selecting either the Hand Cursor or 

the Select Cursor. The descriptions of each of these commands appear within 

the User Manual in the Tool Bar Icon section. 

 

These set of icons include: 

 

•   Select Cursor 

•   Hand Cursor 

 

Resolution Bar  
 

The Resolution Bar Icons allow for quick access to commands that control the 

resolution of the visual image, the resolution of the saved image, along with the 

selecting of the Region of Interest (ROI) size.  The descriptions of each of these 

commands appear within the User Manual in the Tool Bar Icon section. 

 

These set of icons include: 

 

•    Display Image Resolution 

•    Record Image Resolution 

•    Quick Region of Interest  

•    Region of Interest Setup  
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Record Bar   
 

The Record Bar Icons allow for quick access to selecting either the Star/Stop 

Recording or Recording Setup Controls.  The descriptions of each of these 

commands appear within the User Manual in the Tool Bar Icon section. 

 

These set of icons include: 

 

•   Start/Stop Recording 

•   Recording Setup 

 

ImageOpt Bar  
 

The ImageOpt Bar Icons allow for quick access to commands 

that control the orientation and display options of the visual image. The 

descriptions of each of these commands appear within the User Manual in the 

Tool Bar Icon section. 

 

These set of icons include: 

 

•  Horizontal Flip 

•  Vertical Flip 

•  Monochrome 

•   Inverse 

•  Overexposure Sign 

Each of these bars can be moved and adjusted by left-click and hold on the 

symbol that precedes each bar .  This will allow you to customize the feel your 

StarVision Software. 

 

  

Docking Windows   
 

On choosing this control, the software will open-up its side drop-down list where 

you can select what Information Windows you would like displayed on the 

screen. You will have the option of either displaying the Camera Setup Window, 

the Histogram Window, the Guide Window, or the Image List Window. Plus, you 

have the option of also displaying the Output Window with any of the above 

Windows. The checkmark will indicate which Windows are currently being 

displayed. 
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The following is a description of each of the Windows and their functions: 

 

Camera Setup Window   
 

This Window displays the controls for adjusting the 

settings on the StarVision Camera. For details on the 

individual commands, look for the Camera Setup Title 

later in this User Manual. 

 

 

Histogram Window 
 

This Window displays the Histogram Window for 

adjusting the image on the StarVision Camera’s 

output. For details on the usage of this Window, look 

for the Histogram Title later in this User Manual. 

 

 

 

Guide Window 
 

This Window displays the Guide Window (mini-

duplicate) for examining the current output when the 

main Image Window is covered by another 

application. For more details on the Guide Window, 

look for the Guide Title later in this User Manual. 

 

 

 

 

Image List Window  
 

This Window displays the Image List Window for 

examining the current image files that have be 

previously opened in this session. Snapshots of the 

image will appear in the window for easy access. For 

more details on the Image List Window, look for the 

Image List Title later in this User Manual. 
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Output Window 
 

This Window will be located below any of the previous 

selected Windows. It displays a list of the selected 

commands made by you so you can review what 

major operations you have performed on your image. 

For more details on the Output Window, look for the 

Output Window Title later in this User Manual. 

 

 

Status 
 

This command displays the status line located on the bottom of the StarVision 

Window. This line displays current mouse location on Window Grid, current Color 

components at the Mouse location. Number of Frames Captured, Displayed or 

Lost, and the current Captured and Displayed Frames per Second.  

 

 
 

 

Full Mode  
 

This command displays all of the Windows selected in the View Command Tab. 

This should be the default setting for you to view the controls as well as see the 

live image in the Video Window.  

 

 

Simple Mode  
 

This command displays just the View Window of the live StarVision camera’s 

output. No other Information Windows or Command Icons are displayed.   
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Size 
 

This Drop-Down Menu will allow you to Zoom in and out the 

Live Video image as well as set the aspect ratio of the Video 

Window.   

 

 

Zoom In   
 

This control Zooms-In on the live Video Window (enlarges the Video Image). 

Every time you select this command the image will increase by 5% to a 

maximum of 1000%.  

 

 

Zoom Out   
 

This control Zooms-Out on the live Video Window (reduces the Video Image). 

Every time you select this command the image will decrease by 5% to a 

minimum of 10%.  

 

 

1:1   
 

This control sets the Video Image to the aspect of 1 to 1 to maximize the image 

within the current Video Window Size. The true aspect will be maintained on the 

screen as scroll bars may appear to allow you to move the image to view other 

areas that are off screen.  

 

 

Adapt Size   
 

This control sets the Video Image to the correct aspect ratio, but the whole 

image is resized to fit inside the Video Window. The true aspect will be 

maintained on the screen and no scroll bars will be displayed as the whole 

image is inside the Video Window. Use this command when you want to view the 

complete image in your Video Window after you have resized your StarVision 

Window or have manual resized the image using the Zoom Commands. 

 

 

Full Screen   
 

This control sets the Video Image to full size of computer monitor. No other 

commands are visible on the monitor besides the Video Image. You can use 

your mouse’s scroll wheel to Zoom-In or Zoom-Out of the image.  

 

To return back to the StarVision’s original size (with all commands available), just 

press on the Escape Key (esc) on your keyboard. 
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Cursor 
 

This Drop-Down Menu will allow you to choose between two 

mouse cursor techniques when inside the Video Image 

Window. You have the option of either Select or Hand. We 

recommend you use Select as the default. The checkmark will indicate the 

current setting.  

 

 

Select    
 

This control sets the cursor style to the standard cursor arrow. With this style 

chosen you are able to point and click with the mouse, and well as left-click and 

hold to select areas of interest on the screen when required by specific StarVision 

software commands. 

 

 

Hand      
 

This control sets the cursor style to the hand symbol. With this style chosen you are 

able to left-click and hold to drag the Video Image around the Video Window.  

The mouse will automatically change back to the arrow when pointing outside 

the Video Window. 

 

 

Image Opt 
 

This Drop-Down Menu will allow you to choose the options on how 

you would like the image displayed in the Video Window. Also 

from here you can select Auto Exposure and White Balance 

settings along with on screen Over Exposure indicators. 

 

 

Image Mirror     
 

This control will open-up its side drop-down list that provides options on either 

flipping the image horizontally and/or vertically. A checkmark will indicate if 

either or both have been activated. 
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Image Rotation     
 

This control is not yet activated. 

 

 

Inverse      
 

This control will inverse the image on the Video Window. This can be useful when 

imaging the Sun. 

 

 

Monochrome      
 

This control will convert the color image on the Video Window to a black and 

white image. This can be useful when examining subtle details on the image. 

 

 

Auto Exposure      
 

This control will activate the Auto Exposure control on the StarVision Camera. The 

camera’s exposure will automatically change to reflect the conditions displayed 

in the whole Video Window. This command is not too useful for astronomical 

imaging.  

 

 

Area Auto Exposure      
 

This control will allow you to select an area on the Video Window by left-click 

and drag technique (you will notice a red rectangle being drawn to show the 

selected area). The StarVision camera will use this selected area as the region to 

look at when setting its Auto Exposure value. 

 

 

Once White Balance      
 

This control will allow you to have the StarVision Camera perform a white 

balance on the image. With an image on the screen, this command will adjust 

the colors to try to provide the proper color range for the object (based on the 

while video image). 

 

 

Area White Balance      
 

This control will allow you to select an area on the Video Window by left-click 

and drag technique (you will notice a red rectangle being drawn to show the 

selected area). The StarVision camera will use this selected area as the region to 

look at when setting its White Balance value. This is useful if multiple targets are 

on the screen, and you are interested in correcting color on one of them. 
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Over Exposure Sign      
 

This control will allow let the StarVision Camera indicate areas of overexposure 

via a sparkly red overlay on those real-time image.  

 

 
 

 

 

Settings 
 

This Drop-Down Menu will allow you to choose the 

settings on how you would like the single image 

snapshot capture and video capture. You can set the 

language and StarVision display Preferences from these 

commands. Selecting: Capture Settings, Record Settings, 

Language Settings, Preference Settings, and Advance 

Settings will pop-up the same Settings Window. It is from 

within the Settings Window that you will be allowed to 

adjust the individual settings. 

 

  

 

Over 

Exposure 
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Capture Settings        
 

This control will pop-up the Settings Window. In the settings 

Window select the Capture Settings -> General on the side 

to display the Capture Settings controls (this should be the 

default).  

 

 

 

This Settings Window will allow you to set 

the format of the saved images under 

the Image Type Heading. You can select 

one or more formats the images to be 

saved under (if you select more than 

one format, then StarVision will save the 

same image in those selected formats). 

Just check the format(s) that you are 

interested in having StarVision save the 

image under when you select the save 

(snapshot) command. 

 

 

 

 

Image Path will allow you to select the location where you would like the 

image(s) to be saved. You can select a Prefix and a Profix addition to be joined 

to your file name to provide a more informative file name description. 

 

The Image Name Setup will show you the selected naming convention you have 

chosen using the Prefix and Profix types. 

 

 
 

Once happy with your selection, just click on OK to accept. 
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If you select the Capture Settings -> Advanced on the side 

to display the Capture Settings controls, then the Settings 

Window will provide controls for you to set the Continuous 

Snapshot settings.  

 

 

 

You can set the time separation (in minutes and seconds) between each 

successive snapshot (StarVision will wait this duration before taking first image), 

plus you can also indicate how many frames to take (End condition) before the 

snapshot process aborts. 

 

 
 

Click on the Continuous Snapshot Icon to start the process, and again Click on 

the Continuous Snapshot Icon to abort the process after settings have been 

made (unless you have set an End condition). 

 

 

Record Settings        
 

This control will pop-up the Settings Window. In the settings 

Window select the Record Settings -> General on the side to 

display the Record Settings controls.  

 

 

 

This Settings Window will allow you to set 

the format Quality of the saved Video 

under the Image Record Codec 

Parameter Heading. You can also set 

location and naming convention used 

when saving a video of the currently 

displayed image. 

 

Record Path will allow you to select the 

location where you would like the 

image(s) to be saved. You can select a 

Prefix and a Profix addition to be joined 

to your file name to provide a more 

informative file name description. 
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The Record Name Setup will show you the selected naming convention you have 

chosen using the Prefix and Profix types. 

 

 
 

Once happy with your selection, just click on OK to accept. 

 

 

If you select the Record Settings -> Advanced on the side to display the Capture 

Settings controls, then the Settings Window will provide controls for you to set the 

Optional End condition settings.  

 

 

 

 

 

 

 

You can set the time duration (in minutes and seconds) that the recording 

should take (else the recording will continue until you tell it to stop).  Select the 

Checkbox, then enter the duration in minutes and seconds. Click on OK to 

accept these settings. 

 

 
 

 

Click on the Record Start/Stop Icon to start the process, and again Click on the 

Record Start/Stop Icon to abort the process after settings have been made 

(unless you have set an End condition). 
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Language Settings        
 

This control will pop-up the Language Settings Window 

providing you a drop-down list of current langauges. 

 

 

 

 

 

 

 

 

Clicking on the drop-down box will provide a choice of languages (Simplified 

Chinese and English). Choose your language of choice (most likely English), then 

click on OK to accept. 

 

 

Preference Settings     
 

This control will pop-up the Preference Settings Window. In 

the Settings Window should be a checklist of what 

information you may need to display on the Status Bar. Just 

Check-mark the require information and Click on the OK 

button to activate (the default is all checked). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Coordinates RGBs 
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Display 
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Capture 
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Display 

Rate (fps) 
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Advanced Settings     
 

This control will pop-up the Advanced Settings Window. In 

the Settings Window should be three sections for advanced 

control: GigE, Color Matrix, and Camera Advanced 

Settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

GigE Parameter:  This is for possible future usage and is currently de-activated. 

 

Color Matrix: This allows you to set a RGB Color Matrix setting for your system’s 

color display. It is recommended that you leave this control alone unless you are 

familiar with a RGB matrix and how to apply them to your images. You can save 

your own matrix pattern and reload it again when required from this control. 

 

Camera Advanced Settings:  

Clicking on the drop-down box will provide a choice of languages (Simplified 

Chinese and English). Choose your language of choice (most likely English), then 

click on OK to accept. 

 

 

Windows 
 

This Drop-Down Menu will provide you a list of the 

current Video Windows (live or image) open in 

StarVision. It will place a checkmark beside the 

Window that is currently active. You can also click 

on a window to make it the active window.  

 

 

Help 
 

This Drop-Down Menu will provide you a list of 

information about the version of software and drive 

currently installed on your computer.  
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Top Menu Icons 

 
 

 

Open Camera Icon 
 

The Open Camera Icon is used to open an existing StarVision Camera that is 

connected to your computer. If you have more than one StarVision camera 

connected, you can use this command to activate a selected model form the 

displayed list.  

 

Once selected, the StarVision software will open up 

a Window displaying a list of compatible camera 

connected and their current status. Just select the 

Compatible model that you would like to view and 

click on the OK Button. That camera’s image will 

then display in the StarVision Video Window. 

 

 

The status indicates which camera you are currently using (Playing). 

 

 

 

 

Open Image Icon   
 

Use the Open Image Icon to open an existing saved image on your computer 

and display it in a Video Window Tab.  

 

Once selected, the Open Image 

Icon will open up a Window that 

allows you to select an image 

saved on your computer. You can 

use the window to locate a folder, 

and select an image file to display 

in the StarVision Software Window.  

 

The only format currently accepted 

is in the Bitmap format (bmp) 

 

Once the Image is selected, the software will create a window Tab and will 

display the selected image. The StarVision’s Active Camera Tab will be available 

for you to select, if you would like to return to its window. 
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Play Icon  
 

Use the Play Icon to start the live video imaging from the StarVision Camera. This 

icon is active by default. 

 

 

Stop Icon   
 

Use the stop Icon to stop (pause) the live video imaging from the StarVision 

Camera. Use the previous Play Icon to restart the live video imaging. 

 

 

Snap Icon   
 

This command (so far identical to Save Icon) will take a Snapshot of the current 

camera image and will save that image in the format(s) and location specified 

in the Settings->Capture Settings Command or the Settings Icon.   

 

You can open up the Image List Window on the left of the program so you can 

see a preview (bmp format) of the currently saved images.  

 

You can double click on the preview image to open it up in the Video  

Window Tab. 

 

If you require the Camera Setup and access to the camera controls, just Click on 

the Camera Setup Tab to reactivate it. 

 

 

Continuous Snap Icon   
 

This Icon will take continuous Snapshots of the current camera image and will 

save those images in the format(s) and location specified in the Settings-

>Capture Settings image location. The number of Snapshots and time separation 

between each image is set in the Settings->Capture Settings->Advanced 

location. When activated, the Continuous Snap Icon will be indented to remind 

you that the software is taking continuous snapshots. 

 

The Mallincam StarVision Software will continue taking snapshots until you again 

Click on the Continuous Snap Icon or the it has reached the set number of 

snapshots. 

 

You can open up the Image List Window on the left of the program so you can 

see a preview (bmp format) of the currently saved images.  

 

You can double click on the preview image to open it up in the Video  

Window Tab. 
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Real Time Snap Icon   
 

This Icon will take continuous Snapshots of the current camera image and will 

save those images in the format(s) and location specified in the Settings-

>Capture Settings image location. It will take the specified number of Snapshots 

set in the Settings->Capture Settings->Advanced location with no time 

separation between each image. When activated, the Real Time Snap Icon will 

be indented to remind you that the software is taking continuous snapshots. 

 

The Mallincam StarVision Software will continue taking snapshots until you again 

Click on the Real Time Snap Icon or the it has reached the set number of 

snapshots. 

 

 

Save Icon   

 

This Icon will take a Snapshot of the current camera image and will save that 

image in the format(s) and location specified in the Settings->Capture Settings-

General image location using the specified naming convention set in the 

Settings->Capture Settings->Advanced tab. 

 

You can open up the Image List Window on the left of the program so you can 

see a preview (bmp format) of the currently saved images.  

 

You can double click on the preview image to open it up in the Video  

Window Tab. 

 

 

 

Save-As Icon   

 

This Icon will take a Snapshot of the current camera image and will save that 

image in bmp format to the location specified in the Save As Pop-up Window 

that appears. Use the Window to select a location, files name, and format that 

you would like the image to be saved under.   
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Settings Icon     
 

This Icon will allow you to choose the settings on how you would like the single 

image snapshot capture and video capture. You can set the language and 

StarVision display Preferences from these commands. Selecting: Capture Settings, 

Record Settings, Language Settings, Preference Settings, and Advance Settings 

will pop-up the same Settings Window. It is from within the Settings Window that 

you will be allowed to adjust the individual settings. 

 

  

 
 

 

Capture Settings        
 

This control will pop-up the Settings Window. In the settings 

Window select the Capture Settings -> General on the side 

to display the Capture Settings controls (this should be the 

default).  

 

 

 

This Settings Window will allow you to set 

the format of the saved images under 

the Image Type Heading. You can select 

one or more formats the images to be 

saved under (if you select more than 

one format, then StarVision will save the 

same image in those selected formats). 

Just check the format(s) that you are 

interested in having StarVision save the 

image under when you select the save 

(snapshot) command. 
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Image Path will allow you to select the location where you would like the 

image(s) to be saved. You can select a Prefix and a Profix addition to be joined 

to your file name to provide a more informative file name description. 

 

The Image Name Setup will show you the selected naming convention you have 

chosen using the Prefix and Profix types. 

 

 
 

Once happy with your selection, just click on OK to accept. 

 

 

If you select the Capture Settings -> Advanced on the side 

to display the Capture Settings controls, then the Settings 

Window will provide controls for you to set the Continuous 

Snapshot settings.  

 

 

 

You can set the time separation (in minutes and seconds) between each 

successive snapshot (StarVision will wait this duration before taking first image), 

plus you can also indicate how many frames to take (End condition) before the 

snapshot process aborts. 

 

 
 

Click on the Continuous Snapshot Icon to start the process, and again Click on 

the Continuous Snapshot Icon to abort the process after settings have been 

made (unless you have set an End condition). 
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Record Settings        
 

This control will pop-up the Settings Window. In the settings 

Window select the Record Settings -> General on the side to 

display the Record Settings controls.  

 

 

 

This Settings Window will allow you to set 

the format Quality of the saved Video 

under the Image Record Codec 

Parameter Heading. You can also set 

location and naming convention used 

when saving a video of the currently 

displayed image. 

 

Record Path will allow you to select the 

location where you would like the 

image(s) to be saved. You can select a 

Prefix and a Profix addition to be joined 

to your file name to provide a more 

informative file name description. 

 

The Record Name Setup will show you the selected naming convention you have 

chosen using the Prefix and Profix types. 

 

 
 

Once happy with your selection, just click on OK to accept. 

 

 

If you select the Record Settings -> Advanced on the side to display the Capture 

Settings controls, then the Settings Window will provide controls for you to set the 

Optional End condition settings.  
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You can set the time duration (in minutes and seconds) that the recording 

should take (else the recording will continue until you tell it to stop).  Select the 

Checkbox, then enter the duration in minutes and seconds. Click on OK to 

accept these settings. 

 

 
 

 

Click on the Record Start/Stop Icon to start the process, and again Click on the 

Record Start/Stop Icon to abort the process after settings have been made 

(unless you have set an End condition). 

 

 

Language Settings        
 

This control will pop-up the Language Settings Window 

providing you a drop-down list of current langauges. 

 

 

 

 

 

 

 

 

Clicking on the drop-down box will provide a choice of languages (Simplified 

Chinese and English). Choose your language of choice (most likely English), then 

click on OK to accept. 
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Preference Settings     
 

This control will pop-up the Preference Settings Window. In 

the Settings Window should be a checklist of what 

information you may need to display on the Status Bar. Just 

Check-mark the require information and Click on the OK 

button to activate (the default is all checked). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

Advanced Settings     
 

This control will pop-up the Advanced Settings Window. In 

the Settings Window should be three sections for advanced 

control: GigE, Color Matrix, and Camera Advanced 

Settings. 

 

 

 

 

 

 

 

 

 

 

 

GigE Parameter:  This is for possible future usage and is currently de-activated. 
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Color Matrix: This allows you to set a RGB Color Matrix setting for your system’s 

color display. It is recommended that you leave this control alone unless you are 

familiar with a RGB matrix and how to apply them to your images. You can save 

your own matrix pattern and reload it again when required from this control. 

 

Camera Advanced Settings:  It is better to control Hot Pixel removal thru the 

Camera Setup>Image>Dead Pixel control rather than play with the Hot pixel 

remove routines here. 

 

 

Zoom-In Icon     
 

Clicking this Icon Zooms-In on the live Video Window (enlarges the Video 

Image). Every time you click this Icon the image will increase by 5% to a 

maximum of 1000%.  

 

 

Zoom-Out Icon     
 

Clicking this Icon Zooms-Out on the live Video Window (decreasing the Video 

Image). Every time you Click this Icon the image will decrease by 5% to a 

minimum of 10%.  

 

 

Zoom Drop-Down Icon     
 

This drop-down window allows you to select from a list of pre-

selected Zoom Sizes. Click on the drop-down arrow to display the 

Size options and move cursor to the required Zoom Size. The 

current Zoom Size appears in the main Zoom Drop-Down Icon. 

 

 

1 to 1 Icon     
 

This Icon sets the Video Image to the aspect of 1 to 1 to maximize the image 

within the current Video Window Size. The true aspect will be maintained on the 

screen as scroll bars may appear to allow you to move the image to view other 

areas that are off screen.  

 

 

Adapt Window Icon      
 

This Icon sets the Video Image to the correct aspect ratio, but the whole image is 

resized to fit inside the Video Window. The true aspect will be maintained on the 

screen and no scroll bars will be displayed as the whole image is inside the Video 

Window. Use this Icon when you want to view the complete image in your Video 

Window after you have resized your StarVision Window or have manual resized 

the image using the Zoom Icon. 
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Full Screen Icon       
 

This Icon sets the Video Image to full size of computer monitor. No other 

commands are visible on the monitor besides the Video Image. You can use 

your mouse’s scroll wheel to Zoom-In or Zoom-Out of the image.  

 

To return back to the StarVision’s original size (with all commands available), just 

press on the Escape Key (esc) on your keyboard. 

 

 

Select Icon   

 

This Icon sets the cursor style to the standard cursor arrow. With this style chosen 

you are able to point and click with the mouse, and well as left-click and hold to 

select areas of interest on the screen when required by specific StarVision 

software commands. 

 

 

Hand Icon   

 

This Icon sets the cursor style to the hand symbol. With this style chosen you are 

able to left-click and hold to drag the Video Image around the Video Window.  

The mouse will automatically change back to the arrow when pointing outside 

the Video Window. 

 

 

Resolution Icon    

 

The Resolution Bar Icons allow for quick access to commands 

that control the resolution of the visual image (the left drop-down 

box) and the resolution of the saved image (the right drop-down 

box). Click on the down arrow and choose  

the required resolution. 

  

 

Fast ROI Icon   

 

To improve the Though-put (Frames per Second) or if you want to isolate the 

planetary object, choose a Region of Interest (ROI) that just includes the image 

of the planetary object.  

The Fast ROI Icon, once Clicked, will allow you to draw a rectangle around the 

Object that you would like to isolate by holding down the Left Mouse Button and 

Dragging to contain the object. Once enclosed, simply release the button and 

the screens image will now only contain what you had selected.  
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You will see, on the Icon Row, the Screen Resolution and the Capture Resolution 

indicators both say ROI to remind you that you are in ROI Mode. 

 

 
 

 

 

 

To return back to Full Video Mode, just choose the Screen Resolution that you 

require from the left Screen Resolution drop down list (1360x1024). 

 

 
 

Using the Scroll Wheel on your mouse, when the mouse is over the Image 

Window, will enlarge and reduce the image size in the Image Window. 

 

 

ROI Setup Icon   

 

The ROI Setup Icon will allow you to manual define the Region of Interest size. By 

selecting this icon, StarVision will pop-up the ROI Area Setup Window. 

 

 
You can select the upper left anchor point (x1, x2) and the lower Right anchor 

point (x2, y2), or set the required Width and Height (you can even lock it in 

place). It easier to use the Fast ROI Icon to select ROI Window Size. 

 

Hint 

Screen 
Resolution 

Capture 
Resolution 
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Record Start/End Icon   

 

This Icon Starts and Stops the live Video Recording process. The recording name 

and location are set using the Record Setup Icon. 

 

 

Record Setup Icon   

 

This Icon will pop-up the Settings Window. In the settings 

Window select the Record Settings -> General on the side to 

display the Record Settings controls.  

 

 

This Settings Window will allow you to set 

the format Quality of the saved Video 

under the Image Record Codec 

Parameter Heading. You can also set 

location and naming convention used 

when saving a video of the currently 

displayed image. 

 

Record Path will allow you to select the 

location where you would like the 

image(s) to be saved. You can select a 

Prefix and a Profix addition to be joined 

to your file name to provide a more 

informative file name description. 

 

The Record Name Setup will show you the selected naming convention you have 

chosen using the Prefix and Profix types. 

 

 
 

Once happy with your selection, just click on OK to accept. 
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If you select the Record Settings -> Advanced on the side to display the Capture 

Settings controls, then the Settings Window will provide controls for you to set the 

Optional End condition settings.  

 

 

 

 

 

 

 

You can set the time duration (in minutes and seconds) that the recording 

should take (else the recording will continue until you tell it to stop).  Select the 

Checkbox, then enter the duration in minutes and seconds. Click on OK to 

accept these settings. 

 

 
 

 

Click on the Record Start/Stop Icon to start the process, and again Click on the 

Record Start/Stop Icon to abort the process after settings have been made 

(unless you have set an End condition). 

 

 

 

Horizontal Flip Icon    
 

Clicking on this Icon will flip the window image Horizontally. That is, the Left side 

of the screen image will become the Right side, and the Right Side of the screen 

image will become the Left side.  
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Vertical Flip Icon  

 

Clicking on this Icon will flip the window image Vertically. That is, the Top side of 

the screen image will become the Bottom side, and the Bottom Side of the 

screen image will become the Top side.  

 

   
 

 

 

Monochrome Icon  

 

 

Clicking on this Icon will change the colored image to a monochrome image. 

 

   
 

 

Inverse Icon  

 

Clicking on this Icon will invert the colors on the Image Window.  
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Overexposure Sign Icon  

 

This Icon will allow let the StarVision Camera indicate areas of overexposure via a 

sparkly red overlay on those real-time image.  

 

 
 

Left Control Tabs 

The Left side of the screen provides active Windows 

for you to control the StarVision camera and make 

adjustments to the Image Window. 

 

When you select the Camera Setup Tab (see middle 

Tab area), then the StarVision software will allow you 

to control the Camera Exposure, Image, Color, 

Camera Setup, and Triger setup. 

 

Camera Exposure 

 

 
 

Sometimes you may not see the whole Camera Exposure Window, if this is the 

case just click-hold-and drag the top of the Output Window down to see the 

whole Camera Exposure Window. 

 

 

Over 

Exposure 
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Camera Exp 

 

Check marking the Auto Exp will activate the auto exposure routine within the 

StarVision camera. The camera will attempt to provide the proper exposure for 

the image, based on the target value (not too useful for astronomical 

applications).  
 

If you also select the Area AE button, then you are able to draw a rectangle 

around the portion of the image that you would like the auto exposure treat as 

the input zone when making its adjustments. 

 

 

 

You can also include the automatic gain settings in the auto exposure routine by 

checking the Adjust Gain check-mark box. This way both the exposure and gain 

are set by the StarVision camera. 

 

 
 

If Adjust Gain is unchecked, then you can adjust the gain, and the StarVision will 

adjust the exposure with your gain setting. 

 

For our astronomical applications, it is recommended that you leave the Auto Ex 

unchecked. This way you have complete control of the exposure and gain 

settings to match your requirements. 

 
Camera Exp 

 

This control allows you to set the StarVision’s exposure value. 

 

 
 

You can either select a time unit and directly enter in a value, or use the up and 

down arrows in the time unit to increase or decrease StarVision’s exposure. 

 
Light Frequency 

 

For complete astronomical exposure control, set this to DC.  This will allow you to 

set a minimum exposure of 0.53 micro-seconds. This will allow to image very 

bright daytime objects. The maximum exposure of 59 minutes 59 seconds. 
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Dark Field Correction 

 

One of the more power features of the StarVision software is its ability to take a 

Dark Field. This technique will aid in removing Amp glow and hot/warm pixels 

from you live image. 

 

The process is simply to determine what your maximum exposure will be, then 

cover the telescope and have the StarVision Camera take a Dark Field image at 

this exposure length (thus determining what where the amp glow and hot/warm 

pixels are located). Then you can simply apply this Dark Field exposure to your 

live image and amp glow and hot/warm pixels will drastically be reduced. 

 

Step 1:  Determine and set your maximum exposure (and gain settings). 

 

Step 2:  Cover the Telescope 

 

Step 3:  Click on the Capture Button in the Dark Field Correction section of 

the Camera Exposure Tab to initialize the Dark Field capture. 

 

 

 
 

Once the Remaining Time indication has completed it cycle, you should 

see the line Dark Field Correction Inited! appear in the Output Window. 

 

 
 

Step 4:  Uncover the Telescope. 

 

Step 5:  Image object of interest. 

 

Step 6:  Check the Enable check-mark Box to apply the Dark Field (you 

can always uncheck it if you don’t want Dark Field applied. 

 

 

You now have the option of saving the current Dark 

Field by Clicking on the Export… Button in the Dark 

Field Correction section. The software will open up a 

location for you to save your Dark Fields.  
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We recommend to create a Dark Field location to save you Dark Fields, and 

using a naming technique so you can recall that specific Dark Field for later use.  

 

 
 

You can also click on the Import Button to load a previously saved Dark Field. 

 

 

 

 

 

 

When you power down the StarVision camera, the internal Dark Field data is lost, 

so by saving a Dark Field you have the ability to reload a specific Dark Field of 

your current evenings imaging. 

 

Most of us, will take a new Dark Field during the current session, since it matches 

the current seeing conditions, and not worry about saving or reloading specific 

Dark Fields. Experiment to see which approach is best for you. 

 

 

 

Image 

 

While Still in Camera Setup, Clicking on the 

Image Tab will provide Image controls. 

From here you can modify (ensure that 

the appropriate checkmark is clicked) the 

Gamma, Contrast, Black Level, Sharpness, 

Noise, and 3D Noise. This Window also 

provides an alternative way to do 

Horizontal and Vertical image flips, 

Change image into Monochrome, or even 

set the Image to its Inverse. 

 

One of more powerful routines are hiding 

in this Window, Frame Stacking. Finally, you 

can have StarVision analyze the image for 

Hot or Warm pixels for later removal. 

 

Hint 
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Image 

 

If any of the Image Controls are unchecked, then StarVision will choose the best 

value for you. But, you can manually take control of these settings by check-

marking the appropriate image setting, and then dragging the control to the left 

or right. This allows you to either increase or decrease the value of the current 

control to better tweak your image. Experiment! 

 

Gamma 

 

Since each device has its own unique color handling characteristics (or 

tendencies), color information cannot be output exactly as input. The color 

handling characteristics that arise in input and output are known as Gamma 

characteristics. When you adjust the Gamma, you can lighten up area of the 

screen that otherwise may be too dim to see the detail. 
 

 

Contrast 

 

Contrast is defined as the separation between the darkest and brightest areas of 

the image. Increase the contrast and you increase the separation between dark 

and bright, making shadows darker and highlights brighter. Decrease the 

contrast and you bring the shadows up and the highlights down to make them 

closer to one another. Adding contrast usually adds "pop" and makes an image 

look more vibrant while decreasing contrast can make an image look duller. 

 

Black Level 

 

Black Level is defined as the level of brightness at the darkest (black) part of a 

visual image or the level of brightness at which no light is emitted from a screen, 

resulting in a pure black screen. Adjusting this slider, you can make the “Black” 

more prominent.  

 

Sharpness 

 

Sharpness can be defined as edge contrast, that is, the contrast along edges in 

a photo. When we increase sharpness, we increase the contrast only along/near 

edges in the image while leaving smooth areas of the image alone. 

 

Noise 

 

Digital Noise Reduction (DNR) technology utilizes temporal noise reduction. This 

technique basically compares one frame to the next and removes any tiny 

specs in each frame that do not match. The idea is that by blending the frames, 

the overall noise content in an image is reduced. By adjusting the slider, you are 

affecting the aggressiveness of the routines in the StarVision Camera. 

 

 

 

https://en.wikipedia.org/wiki/Brightness
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3D Noise 

Not only does 3D DNR handle the traditional frame-to-frame noise reduction, but 

it also incorporates spatial noise reduction. 

Spatial noise reduction compares a pixel with its neighboring pixels to detect 

and remove unwanted noise found within the frame. It processes the entire 

image to remove digital artifacts and grainy appearance while better 

maintaining image clarity and sharpness. 

 
Raw to RGB 

 

StarVision uses its own image capturing algorithms to enhance its features, but 

then has to convert it to RGB for you to perform color corrections. This Drop-down 

lost provides alternative conversion techniques. We recommend you leave it as 

Normal, but hey it’s your camera, so don’t be afraid to see if you notice any 

improvement when using other conversion algorithms (especially when imaging 

sun, moon, or planets). 

 

 
 

You can also flip the Window Horizontally or Vertically (or both) as well as invert 

or make the image monochrome by checking the appropriate checkmarks 

under the Raw to RGB control. 

 

 
 

 
Frames Stack or Mean 

 

This control allows you to stack the images that appear on the screen. This will 

improve the signal to noise level and thus improve (brighten with more detail) the 

image without having to perform long single exposures. 

 

Using the slider, or enter in a number to indicate how many image you would like 

stacked at the current exposure. 
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Select if you want the imaged stacked (Stack) on top of each other (will make 

brighter with more details), or do you want them averaged together (Mean) 

which will reduce noise in image. 

 

 
 

Check the Enable box to start the Stacking or Averaging. The 

Output Window will keep you informed of the progress.  

 

 
 

To stop the Stacking, just uncheck the Enable box. 

 

 

 

 

 

You also have the ability to save every stacked image to your designated file 

location with the chosen formats (See Settings Tab or Icon for instructions on how 

to set these. 

 

Check-mark the Save Check Box 

 

When stacking, the default process is to display the final Stacked image, but you 

can also have it display each image as it stacks on to the previous image by 

Check-marking the Display All Box. 

 

 
Dead Pixel 

 

Every camera will exhibit hot or warm pixels (it’s the nature of the beast).  

 

A Hot pixel is a cell of the imaging chip of a camera that is always reading on so 

will appear white (or another color). A warm pixel is a cell that after long 

exposures will act like a Hot pixel, but will act normally on short exposures. 

 

The StarVision software will give you the ability to map those pixels, and will 

mathematically remove them from the real time image. This way there are no 

bright pixels on your screen. 
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To Start the mapping process, Click on the Collect pixel button. StarVision will 

then pop up an Instruction Window. 

 

 
 

We recommend covering the telescope so your Screen image is dark (except for 

any hot pixels that the camera is producing). 

 

You can use the sliders on this Window to adjust the Gain and the Exposure Time, 

but you will not have an idea of what the settings are. We find it easier to use the 

Gain and Exposure Time settings in the Camera Exposure Tab to determine a 

condition in which Hot/Warm pixels appear. Now go back to the Collect Dead 

Pixel Window and you will notice that the sliders have self-adjusted to your 

settings. 

 

To start the process, Click on the OK Button. 

 

StarVision will then pop-up a Tip Window informing you that it is determining 

where those Hot/Warm pixels are. The process may take about a minute to 

complete. 

 

 
 

Once completed, a Message Window will appear indicating if it was successful 

in determining where those Hot/Warm pixels are. 

 

 
 

That’s it. You can repeat this process as necessary. But we recommend you to 

use this procedure when Hot/Warm pixels are affecting your image. 

 

StarVision will automatically apply the correcting to your live imaging. 
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I have found that sometimes after using this command, the StarVision software 

resets some of the setting on the Camera (Auto Exposure is Set, Frequency to 50 

Hz, color balance needs to be re-adjusted). So just re-adjust them back to your 

required settings. 

 

 

Color 
 

The Color Tab will present the Control Window that allows you to tweak the colors 

and saturation of the image, plus given you the option setting the White 

Balance. 

 

 
 

 
Color 

 

These controls allow you to set the individual color gain (red, green, and blue). 

Just move the slider unstill required colors match your needs. The box beside the 

slider will indicate its value for reference sake. 

 

 
 

You can also set the color saturation by first check marking the Saturation Check 

Box, then moving its slider to achieve the desired results. 

 

 
 

 

 
White Balance 

 

White balance (WB) is the process of removing unrealistic color casts, so that 

objects which appear white in the real environment are rendered white in your 

images. The color of an object is affected by the lighting conditions under which 
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it is viewed. Our eyes and our brain compensate for different types of light—

that's why a white object appears white to us whether it's viewed in sunlight, 

under overcast skies or indoors under incandescent or fluorescent light. But 

digital cameras need help to emulate this process, to compensate for different 

types of lighting and render a white object white. This is the purpose of White 

Balance. 

 

To activate (correct) the White Balance, just Click on the Once WB buttons and 

the StarVision camera will adjust the White Balance based on the whole image. 

You, can also select a region for which the camera will examine and then adjust 

the White Balance. To perform this latter task, Click on the Area WB button and 

then using your mouse (left Click and Drag) to define a rectangular region for 

the camera to examine. 

 

 
 

Camera Setup 

 

This Window will allow you to determine the frame rate and bit resolution that the 

camera uses to capture and display its images. This Window also allows you to 

set the Preview and Capture resolutions along with Region of Interest size. 

 

 
 
Camera Setup 

 

Frame Speed 

 

This control lets you choose from 3 frame speeds when 

download the images from the StarVision Camera. 

Your choice are: Normal, High, and Super. 

 

Depending upon the age of your computer and its processor, along with 

number of active usb ports, these factors determine what setting to use. Try 

Super first and if you drop frames, or image lags, move to High, then down to 

Normal if High is too much for your hardware. 
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Media Type 

 

This control determines the bit resolution the StarVision 

camera uses to capture and save its images. Your 

choice is either in an 8-bit or a12-bit mode. 

 

8-bit data is faster and takes less space than 12-bit data, but 12-bit data gives 

you more color separation in its images. 

 

 
Camera Setup 

 

Preview 

 

This drop-down folder allows you to select what 

resolution you would like to display the current real 

time images in. you have a choice of: 1360 x 1024, 

1280 x 720, 680 x 512 mono, 680 x 512 color, and 340 

x 256 mono. 

 

We recommend using the full 1360 x 1024 unless you have another preference. 

 

Capture 

 

This drop-down folder allows you to select what 

resolution you would like to save your images or 

videos in. you have a choice of: 1360 x 1024, 1280 x 

720, 680 x 512 mono, 680 x 512 color, and 340 x 256 

mono. 

 

We recommend using the full 1360 x 1024 unless you have another preference. 

 

 
ROI 

 

Fast ROI Button  

 

To improve the Though-put (Frames per Second) or if you want to isolate the 

planetary object, choose a Region of Interest (ROI) that just includes the image 

of the planetary object.  

The Fast ROI Button, once Clicked, will allow you to draw a rectangle around the 

Object that you would like to isolate by holding down the Left Mouse Button and 

Dragging to contain the object. Once enclosed, simply release the button and 

the screens image will now only contain what you had selected.  
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You will see, on the Icon Row, the Screen Resolution and the Capture Resolution 

indicators both say ROI to remind you that you are in ROI Mode. 

 

 
 

 

 

 

To return back to Full Video Mode, just choose the Screen Resolution that you 

require from the left Screen Resolution drop down list (1360x1024). 

 

 
 

Using the Scroll Wheel on your mouse, when the mouse is over the Image 

Window, will enlarge and reduce the image size in the Image Window. 

 

ROI Setup Button  

 

The ROI Setup Button will allow you to manual define the Region of Interest size. 

By selecting this icon, StarVision will pop-up the ROI Area Setup Window. 

 

 
 

You can select the upper left anchor point (x1, x2) and the lower Right anchor 

point (x2, y2), or set the required Width and Height (you can even lock it in 

place). It easier to use the Fast ROI Icon to select ROI Window Size. 

 

 

Hint 

Screen 
Resolution 

Capture 
Resolution 
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Camera Setup 

 

This Window will allow you to set up an exposure trigger situation. This has no 

application for our astronomical needs.  

 

We recommend that you leave the Trigger Mode as Continuous and not 

experiment with these controls. As it can confuse the camera settings. If you did 

experiment and cannot seem to fix, then use the File->Default Camera Setup 

command from the top Tab. You will need to readjust some of the Camera 

exposure settings. 

 

 
 

Histogram 

 

Selecting Histogram from the Middle Tab Location will replace the Camera Setup 

Window with the Histogram Window.  
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This Window displays a real time Histogram of the current images being 

displayed. A Histogram is a graphical representation of the pixels exposed in your 

image.  The left side of the graph represents the blacks or shadows, the right side 

represents the highlights or bright areas and the middle section is mid-tones 

(middle or 18% grey).  How high the peaks reach represents the number of pixels 

in that particular tone.  Each tone from 0-255 (o being black and 255 being 

white) is one pixel wide on the graph, so imagine the histogram as a bar graph 

all squished together with no spaces between each bar. The purpose of the 

Histogram is to allow you complete control of the gain and color levels being 

generated on your image. The Histogram represents the data being displayed, 

so you can enhance the parameters by selecting the range of data to be 

displayed. 

 

For more detailed information on Histograms visit the following website: 

 

http://www.cambridgeincolour.com/tutorials/histograms2.htm 

 

 

You enter in a value via the of use the up and down arrow next to the Left and 

Right values so that you are not clipping data, on either side of the window. 

These adjustments will help improve the image on the screen. The Histogram Tab 

will take a bit of practice to become comfortable with it (read section in the User 

Manual covering the Histogram Command). As you adjust the Left and Right 

values, you will notice the Black Histogram Indicator Bars move to the left or right. 

The data is represented by the colors on the Histogram. 

 

 

You can adjust the Histogram from either the RGB, or from each 

individual color, plus grey. Just select your choice from the Drop-

Down menu beneath the Histogram, then the left and right value 

will just adjust the specified colors.  

 

You can click on the Auto Button to have the StarVision choose what 

it believed is the best, but we recommend setting your own values.  
 

If you get completely confused with the histogram just go back to 

RGB and Click the Defaults Button (0 to 255).  
 

It takes a while to become comfortable with the Histogram, and most users will 

control you image settings via the Image and Color Tabs. 

 

http://www.cambridgeincolour.com/tutorials/histograms2.htm
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Guide 

 

Selecting Guide from the Middle Tab Location will replace the Camera Setup 

Window with the Guide Window.  

 

 
 

The Guide Window duplicates the Video Window in the upper left corner. The 

advantage of this is that you can drag this window (Left-Click-Hold-and-Drag in 

the darker grey Guide Line) to the side and have a continuous small version of 

the StarVision’s live Video Window on your screen. This way if you have a small 

real estate issue, you can still see the image while another program may overlay 

the primary Video Window. 

 

 
 

If you dragged the Guide Window to the side and you would now like to return it 

to its proper location, just Double Click on the Grey Guide Line and the Guide 

Window will re-seat itself to its home position. 

 

 
 

 

Image List 
 

Selecting Image List from the Middle Tab Location will replace the Camera Setup 

Window with the Image List Window.  

 

 
 

This Window displays the Image List Window for examining the current image files 

that have be previously opened in this session. Snapshots of the image will 

appear in the window for easy access.  

 

Left Click Hold 

and Drag in this 

area to move 

Guide Window  
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The Image List Window keeps track of previously opened images during this 

session or snap shots you have taken during this session. The Image List Window 

will display small duplicates of these images in it window. Double-Clicking on the 

Duplicate Image will display the full image inside the Main Image Window under 

its own tab setting. 

You can return to StarVision’s live image by clicking on the tab “Mallincam 

Vision” in the Video Window. 
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6. Using Optional Software 

 

When you installed the StarVision Software, the installer also included DirectShow 

Drivers and Twain Drivers. These drivers make the StarVision Camera available to 

be controlled by other software packages that can control DirectShow or Twain 

cameras. 
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Running PHD2 with WDM Driver 

Start PHD2 software 

 

 
 

Click on the Camera Icon to open up Connect Equipment Window. 

 

Step 1 

Step 2 
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Choose WDM-style webcam camera from Camera Dropdown List. 

 

 
 

 

Left-Click on the Connect button on Camera List. 

 

Step 3 

Step 4 
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The Camera choice window will pop-up. Select MallinCam Vision and Click on 

OK. 

 

 
 

 

 

 

 

Select Resolution 1360x1024 and Click on OK 

 

 

 
 

Choose your ASCOM Mount driver from the Mount Dropdown List 

 

Step 5 

Step 6 

Step 7 
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Left-Click on the Mount and Camera Connect Buttons activate the connection 

between both the mount and Camera.  
 

 
 

Click on Close to close the Connect Equipment Window. 

 

 

Step 8 

Step 8 

Step 9 
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You will be returned to the PHD Main Screen. 

 

Left-Click on the Looping Icon to start the StarVision imaging.  

 

 
 

PHD2 cannot control the StarVision WDM driver directly thru the timer (so leave 

this at 0.01s). You set the StarVision timer controls via the Camera Settings Icon 

 

 
 

This will pop-up the StarVision Properties Window where you can control all 

aspects of the camera. 

 

Step 10 

Step 11 
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Click on OK to set these time parameters and control will return back to PHD2, so 

it can display the image and do its auto-guiding 
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7. Appendix 

Imaging in SharpCap 

With the addition of the StarVision Direct Show Driver, you can control the 

StarVision with a variety of other pieces of Software such as SharpCap. Now this is 

the first generation of DirectShow/Sharpcap driver interaction and as such, not 

all of the commands are perfect for user control. 

 

SharpCap can be obtained at http://www.sharpcap.co.uk/ 

 

Start SharpCap 

 

 
 

Chose Cameras from the Top Heading Tab, then in the DirectShow Cameras, 

pick MallinCam Vision. 

 
 

http://www.sharpcap.co.uk/
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Once you have selected, the Mallincam Vision Driver, SharpCap will display 

what the StarVision is imaging. 

 

 

The controls on the right of the screen (Exposure, Gain, Gamma, …) allow you to 

change the settings of the StarVision. 

It takes a bit of practice to become familiar with the settings as these a more 

generic controls, the majority of the controls have their own scales (the exposure 

does not indicate seconds, but has moves up by a factor of 2).  

Sharpcap will display the exposure you have set on the bottom of the SharpCap 

window after the first exposure is taken. 

SharpCap has the ability to Pop-Up the StarVision Video Filter (DirectShow control 

window).  Click on the Show Button in the Video Capture Control 

 

 

The Pop-Up Window gives you some familiarity with settings as it provides you 

with more comfortable units. 
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You can choose the Exposure Tab in the Filter window to set the exposure to the 

decided value as well as setting the gain. The ISP Tab will allow you to adjust 

other image properties.  

Once you are comfortable with the settings, Click on the OK Button in the 

Properties window to close it. 

SharpCap will start the imaging process and will, on the bottom of the 

window, display information about the exposure and remaining time. You can 

watch the green status bar move to the right as the exposure is being taken. 
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First Aid for the StarVision Series 

When I click on the StarVision camera from the Camera list, a message pops up 

saying Failed to Start: StarVision 

 

There is an issue establishing fulltime communications with the camera. This can 

occur for a variety of reasons but the mist common one is the cable is too long 

for the USB port on that specific computer to establish the correct timing 

protocol. This is more so with USB 3.0 devices. 

 

Recommended solution: if you need to use a longer length of USB 2.0 cable for 

the StarVision, then there are two options: 

 

➢ Connect a powered USB 2.0 hub to the computer and connect the USB 

cable between the hub and the StarVision camera. 

➢ Connect an active (not passive) USB 2.0 extension cable between the 

camera and the included USB 2.0 cable. Something along the lines of the 

Tripp-Lite USB 2.0 superSpeed Active Extension Repeater Cable 

 

 

 

When I try to connect I receiver message “Catastrophic failure (Exception from 

HRESULT:0x8000FFF(E_UNEXPECTED))” 

 

This message indicates that something has blocked or over written the driver. 

Installing another driver or even a major Windows update has played havoc with 

the original StarVision Drivers. 

 

Recommended Solution: Uninstall the current driver through the Control Panel (or 

if you cannot find it in the Control Panel check out the c:/PROGRAM 

FILES(x86)/MALLINCAM/mallincam folder, there is a program called Mallincam. 

Double-Click on Mallincam to start the program. You can uninstall StarVision and 

its drivers from here. 

 

Once uninstalled, reboot your computer, then reinstall StarVision again using the 

same Mallincam program as in the above. Do not plug in the StarVision camera 

until you have reinstalled the software.This should fix the issue. 

 

 

All I see is a White image 

 

Recommended Solution: Move Gain to the extreme Left (1).  Ensure automatic 

exposure is off. Make sure you are in Camera Exposure Mode. Move exposure to 

minimal value say 10ms. Now slowly cover telescope to see if image darkens up 

to a black image as you completely cover up the telescope. If this occurs, then 

the StarVision is working properly so you need to check your telescope and focus 

setup. 
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Dark Field Explanation 

The following is the best explanation of what Dark Field is, and it comes from the 

work of Simon Hanmer. 

 

Dark Field 
 

Dark Field Subtraction  
  

First, take an image with the camera shutter closed or the camera/scope 

covered under the same conditions of exposure time and temperature as the 

light frames you are going to capture of your astronomical target.  Many 

astronomers will take ten or more such dark frames and then combine them into 

a master dark frame, principally for statistical reasons: the more sub-frames, the 

better quality of master frame. 

  

This will give you a single (master) frame of hot and warm pixels generated in the 

imaging chip, electronically and thermally, including amplifier glow. 

  

Second, subtract the dark frame from each of the light frames in order to 

remove hot and warm pixels and amplifier glow. However, other noise will remain 

and needs to be removed with other manipulations and software. 

 

   

Now, how does this work in practice – and why is it called a Dark Field 

correction?  

  

The Dark Field correction is prepared by the user at the beginning of an 

observing session by covering the camera or scope, pre-determining the 

exposure time and setting the software to take up a Dark Field. We all know our 

equipment and the skies we observe under (or we certainly will with a bit of 

practice).  We also have an idea of what range of filters we might use that night 

and the effect they have with respect to exposure times. Take this into account 

when selecting your exposure time for your Dark Field. 

  

But remember: this is NOT a Dark Frame subtraction – the exposures required for 

dark frame subtraction must be close to those used for the light frames of our 

astro-targets. Not so for Dark Field correction. The point here is that camera and 

software will select the appropriate Dark Field for the correction, for both shorter 

and longer light frame exposure times from the same « library ». 

  

In addition, unlike the single frame of a CCD dark frames, the images used for 

Dark Field correction are designed to remove ALL NOISE, not just hot and warm 

pixels. 

  

The important point to retain here is that, because of the stacking and 

combining to form the library of images for the correction procedure, long light 

exposures do NOT require similarly long exposures for the Dark Field correction 

images. For example, a 2-minute light exposure using a narrow-band h-alpha 
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filter may still only require the user to prepare a 30 second dark image for the 

dark field correction. The precise number will vary with your equipment and 

conditions. 

 

The two screen captures below demonstrate the difference that applying a Dark 

Field to an image can provide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

90 second exposure, 

lens covered. Dark 

Fields Applied 

90 second exposure, 

lens covered. No Dark 

Field Applied 
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Setting up to Broadcast on Night Skies Network 

Introduction 
I found that when I first started connecting tonight Skies Network (NSN), things started 

happening too fast for me to keep track of everything at once. So, pre-planning was the most 

the most crucial step for me. I found that by doing test runs in the comfort of my house allowed 

me to develop my techniques that work for the equipment and software that I use. Below are 

the results and steps that I use to broadcast on NSN, feel free to follow them and/or made 

modification as you deem as necessary. 

Computer real-estate will be your nemesis. So, depending upon the size of the 

monitor (laptop), then number of screens that you are using, then number of 

software programs that using are simultaneously are using, will dictate how you 

will manage your windows. I will describe how I have organized my windows 

under a variety of situations (1 computer, 1 computer with 2 monitors, which 

software packages am I using, and what am I trying to do this session).  

Remember, it’s all about having fun, and time and patience are your best friends 

(not to mention all the guys and gals, and the Yahoo – MallinCam site:  

http://tech.groups.yahoo.com/group/mallincam/messages 

One of the most important decisions you will need to make with broadcasting the image of the 

StarVision is what Video capture software are you going to use. Some simple suggestions:  

Currently StarVision is not capable of modifying the Video Image and having that Video Image 

be directly captured by NSN Flash. So if you want to use all the features of the StarVision 

software and broadcast those results, as well as save screen shots and videos of your images, 

then we need another program to capture StarVision’s output and have the output from that 

program linked to NSN’s Flash grabber.  

You currently have three choices for that other program: Splitcam, Manycam, WebcamMax. All 

three have about the same features, some of these have versions that will cost you, but all have 

a version that is free (reduced functions, advertisements, etc…).  My current program of choice 

is Splitcam (I can live with the Advertisements). You will then use Manycam/Splitcam/Webcam 

Max along with StarVision Software to broadcast the images on NSN. 

Plug in the StarVision camera into an USB port on your computer. 

 

Always use the same port for your connected devices. I even mark on my laptop 

which USB port is for which device.  

 

 

 

Note 

Step 1 

http://tech.groups.yahoo.com/group/mallincam/messages
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Start StarVision  

Get the image of your object on the Image Window of StarVision, adjust the settings on the 

software for your planned object and size the window so you have room for other software on 

your monitor real-estate.  If you have a dual Monitor system, move StarVision to the second 

monitor. 

During your initial NSN experience, you will find it easier to even get the object of 

interest onto the StarVision Software window. This allows you to spend some 

time playing and adjusting the settings prior to connecting to NSN. As you become 

more comfortable, you will not worry about that and will adjust while connected 

to NSN (with the whole universe watching you live). 

 

Start Manycam/Splitcam/WebcamMax 

Size the Manycam/Splitcam/WebcamMax window so that is beside the StarVision 

Window and you can see both with little overlap. If you have a dual monitor 

system, you can slide both the StarVision Software Window and the 

Manycam/Splitcam/WebcamMax window to the second monitor. 

 

Have Manycam/ Splitcam/Webcam Max grab the window image 

All of these packages have the ability to get a desktop image. Choose this option 

and overlay the sizing window on top of your StarVision Software Image 

Window. You may need to play with the sizes until you obtain the ideal 

combination of both the fit in your screen. You want to ensure that you get a 

good image of whatever the StarVision Software is looking at inside the 

Manycam/ Splitcam/ Webcam Max window.  

 

 

 

 

 

 

 

 

Step 2 

Step 3 

Step 4 

This allows you to select 

the size and location of 

the desktop that you 

want on the SplitCam. 

Just slide and adjust the 

overlay on top of your 

StarVision’s Software 

image. 
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Adjust the Resolution and frames/second (fps) value on Manycam/Splitcam/WebcamMax 

This will be trial and error; it all depends upon resolution, bandwidth, and what 

over members on NSN experience from your broadcasted image. You will end up 

adjusting both on the Manycam/Splitcam/Webcam Max side as well and on the 

NSN side to get the best image. A helpful hint: I slide over the Manycam/ 

Splitcam/Webcam Max window so that some of the text appears in the 

Manycam/Splitcam/Webcam Max window. Can the members on NSN read the 

words? If not, adjust. Remember, this may take a couple of sessions until you 

obtain the ideal resolutions for your particular setup. For me I have set both 

Manycam /Splitcam at 640 x 480 at 15 fps. 

 
Minimize the Manycam/Splitcam/WebcamMax software window 

Click on the little underscore on the top right side of the Manycam/Splitcam/Webcam Max 

window. This will eliminate the Manycam/Splitcam/Webcam Max window from your desktop (it 

should now appear on the bottom of your desktop monitor), but note that the software is still 

running and still has hold of your desktop (StarVision) Image location.  

Do not move the StarVision Window around your desktop when broadcasting, 

since Manycam /Splitcam/WebcamMax is just grabbing the real-estate location 

that currently your StarVision Software image is situated at. If you move the 

StarVision Software Window, then Manycam /Splitcam/ Webcam Max will still 

grab the desktop location, but may not grab the whole StarVision Video Image. 

Don’t be afraid to practice moving the StarVision Software window when not 

broadcasting to learn how it affects the displayed Manycam/ Splitcam/ 

WebcamMax Window. If you need to, you can again use the Manycam/ Splitcam/ 

WebcamMax desktop select icon and select or change the location or size of the 

window for it to grab. 

If you have a dual monitor, you can leave the Manycam/Splitcam/WebcamMax 

window open on the second monitor since real-estate will not be an issue in the 

situation. In fact with Splitcam, you have an option to view the displayed image in 

full screen mode by clicking on the ”[ ]” symbol in the upper right side of the 

screen (the escape key returns you back to normal size). 

 
Start your Web Browser of Choice 

You may have to play with a number of Browsers to see which one works well with your 

particular computer setup. I have had success with many browsers:  Chrome, Internet Explorer, 

Firefox, and Maxthon.   

 

Step 5 

Step 6 

Step 7 
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Log into Night Skies Network (NSN) 

Have your Web Brower go to the location: http://www.nightskiesnetwork.ca/ . Locate and click 

on the BROADCASTERS AND MEMBERS SIGN IN button. The next Login screen will ask you to 

enter your username and password.   You will next be presented with the Channel Line Up 

screen for Night Skies network.  Click on the Login selection on the upper right hand side of the 

screen. 

 

 

 

 

 

 

You will be presented with the Channel Launch Sign In screen for NSN. Again enter your 

Username and Password and click on Publish Channel button. 

 

Allow Adobe Flash to use your Manycam/Splitcam/WebcamMax 

The Adobe Flash Player Settings window will pop up on your screen asking you for permission 

to use your camera and your microphone. Select Allow. 

 

Step 8 

Step 9 

http://www.nightskiesnetwork.ca/
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Turn off your Microphone 

Until you have your microphone figured out, it is best to initially turn it off. If you do not, the 

viewers on NSN may hear an extreme loud buzzing (feedback noise). Later on we will look at 

using the microphone, but until then I recommend CLICKING on the little microphone symbol on 

the upper right corner of the NSN video display window to disable the microphone.  

 

Set a message for the NSN observers 

It is a good idea to display a message above the NSN display window, so that the other NSN 

views understand what you are doing. When initially setting up (which usually takes longer 

when you are learning), I usually type the message “Setting Up the Camera” then CLICK on the 

SEND button to have it displayed. 

 

When you are us and running and everything is working as it should, you will 

change the message to indicate, what telescope, mount, and camera you are 

using. For that is the most frequently asked question from the NSN viewers. 

 
Select the Camera 

Now is the time to activate the camera, or in our case have NSN driver point to our 

Manycam/Splitcam/Webcam Max output. 

➢ RIGHT CLICK inside the NSN Video window to bring up a Settings Window 

 

Step 11 

Step 10 

Step 12 



StarVision User Manual October 4, 2016 

Mallincam StarVision User Manual Page 105 

 
➢ CLICK on the Settings choice and you will be presented with the Adobe Flash 

Player Settings Window. 

 

➢ CLICK on the Camera Icon and you will be presented with a pull down menu to 

select your camera.  

 

➢ CLICK on the Pull Down list to select your camera of choice.  

 

➢ CLICK on CLOSE to Continue. 

 

NSN will remember what camera you chose from the last visit. So usually you only have to go 

through this process whenever you want to change what camera device you would like the NSN 

flash driver to use. 

Choose your Camera Settings 

We will now select the settings for our camera.  We have the option of changing: The 

Bandwidth, Picture, Resolution, Framerate, and even the microphone rate (when you are 

ready). The changes will not be activated until you CLICK on the Green OK symbol in the 

window. 

➢ LEFT CLICK inside the NSN video Window to bring up the Camera Settings 

Window. 

 

 

Step 13 
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➢ Use the sliders for Band Width and Picture values. I usually have both of my 

sliders way on the right. Over time you will find the sweet spot for your system. 

 

➢ Select your Resolution from the Pull Down Menu. Select a starting value of (640 

x 480) for the system. Again, play with these to see what settings the NSN 

viewers say is the best. 

 

➢ Select your Frame Rate. From its Pull Down Menu.  I usually leave it at 15 fps, 

but I have used 30 fps at times. Again trial and error for your system. 

 

➢ CLICK on the green OK symbol to accept these settings. 

 

That’s it, you are done. If everything is working well and the Window’s gods are in a good mood, 

you should be broadcasting whatever object the StarVision is capturing. You should now enter 

another Message and SEND it out to indicate what system you are using and what object you 

are viewing.  

There is a time delay on what you say (if you have your microphone activated) 

and do on your computer as compared to what others see (and hear) on the NSN 

broadcast. 

You will freeze (and I don’t mean like what Chris does when he broadcasts in 

winter till 3am), I mean from time to time your NSN connection will freeze for no 

apparent reason. It happens to us all. When this happens, you can simply 

terminate the Web browser program (Ctrl –Alt-Del). Then restart your browser 

and Log back into NSN.  This usual is a very quick process. But, sometime we all 

have to restart our computer (this takes longer for we need to power down 

hardware and software) and reactivate everything before login back in.  Don’t 

worry, the NSN viewers sense what is happening and will keep the conversations 

going while waiting for you to come back on. 

Don’t be afraid to ask for advice by typing in on the Video chat window, as we are all learning 

and are willing to assist whenever we can. 

When ready, try activating the microphone (click on the microphone symbol). Other will let you 

know if they can hear you, or if there is noise.  Remember there are settings for the microphone 

in the camera settings window.  

When you are finished with your session, you simply say your good nights to the 

crowd of NSN viewers to let them know that your session is ending.  CLICK on the 

red STOP button on your NSN Window and NSN will shut down your channel and 

you can power down your system and call it an evening (It won’t force the NSN 

viewers off the channel and some viewers will continue chatting long after you 

have gone to bed).  
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Focal Reducers 

 

MFR-8 

  

MFR 8 Mk II Kit. This focal reducer is made for the StarVision Series of cameras. 

Typically, it is a MFR-5 II without the rear (MFR-6) small part. The front lens has a 

high precision achromatic 25 mm double sided coated lens, and includes two 10 

mm spacers and a 5 mm spacer offering a variety of variable focal reduction for 

just about all telescope type. This is an ideal combination for the StarVision Series 

of cameras. If a user already owns a MFR-5 type focal reducer there is no need 

to purchase the MFR-8 II Kit. 

 

The MFR-8 Mk II Kit will vary focal reduction from 0.55X down to about 0.4X.  Test 

result did confirm reduction as low as 0.38X reduction when using the StarVision 

using all supplied spacers. 
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User Notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


